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, it is C:\Program Files\Picture 
ayed in the browse window.

 to the work area. The image is dis-

ialogs. (See Opening Images.)
Menu Index Contents

The Opening ScreenThe Opening ScreenThe Opening ScreenThe Opening Screen
When you first bring up Picture Window, you get a display like 
that shown at right. The menu and tool bar are displayed at the 
top of the window. A Browse window at the left shows 
thumbnails of images in any selected directory. (You can change 
the selected directory by clicking on the button in the 
browse window and choosing a new directory.)

Loading an Image
The first file we want to open is bird.jpeg located in the Pic-
ture Window installation directory. The extension jpeg indi-
cates the file is compressed using the JPEG standard. JPEG is 
designed specifically for photographs and easily achieves com-
pression factors of 6 to 10 with good quality. 

To load the image using the browse window:

1. Select the Picture Window installation direc-
tory. In the browse window, click the button. The 
Select Folder dialog is displayed. Navigate to the installation directory. By default
Window 3.0. Click the Select button. All the images in the directory are displ

2. Open the bird image. To open Bird.jpeg, double-click on the image or drag it
played in its own window. 

You can also load images using the standard File | Open or File | Open Photo CD d
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The Image Window
Notice that the image is displayed in its own image 
window. Since the image window is used throughout 
Picture Window, it is worth noting some of its fea-
tures. 

The title bar of the image window shows the file name 
of the image. Or, if the image has not yet been stored 
in a file, the title bar displays an image number. During 
a session, increasing image numbers are always 
assigned, so that you can be sure that a greater num-
ber means it’s a later version. 

The title bar also displays the image’s magnification. 
You can change the magnification with the Zoom but-
tons in the tool bar. 

Zoom in: Enlarges the image within the image window.

Zoom in and enlarge window: Enlarges the image. Also enlarges the image w

Zoom out: Reduces the size of the image and shrinks the window.

These functions are also available on the Window menu.

Finally, note the number in the lower right corner of the image window. It indicates the num
images have 24 or 48 bits/pixel. Monochrome images have 8 or 16 bits/pixel. 1 bit/pixel ima



Picture Window Tutorial - 12

ating anating anating anating an
eeee

irst display an image, evaluate it 
nt. What would you do to 
 Very few photographs are fin-
 they come out of the scanner.

 the photographs we take have 
ntial ingredients to be good 
e their strengths are brought 
 impact of their defects is 

at the top left is a photo of a 
d, as it looks after scanning. By 
t critically, you can see a num-
s that can be improved. The 

rast is subdued, it has a slight 
 cast, and focus is soft. 

owing pages we work on the 
ges, making a series of improve-
ir cumulative effect is the sec-
shown at left. 

e most, load the image and per-
eps yourself as you read. 
Menu Index Contents

EvaluEvaluEvaluEvalu
ImagImagImagImag
After you f
for a mome
improve it?
ished when

Frequently,
all the esse
images onc
out and the
reduced. 

The image 
fabulous bir
inspecting i
ber of thing
image cont
green color

On the foll
image in sta
ments. The
ond image 

To learn th
form the st

Original image

Final image

C
op

yr
ig

ht
 (

c)
 K

en
 D

ei
tc

he
r, 

19
99

 



Picture Window Tutorial - 13

and Color. Gray contains all the 
r contains functions for adjusting 
n to cropping, it contains functions 
Menu Index Contents

Cropping theCropping theCropping theCropping the
ImageImageImageImage
Since cropping makes the image smaller 
and thus more manageable for your 
computer, it’s a good idea to crop the 
image early in the enhancement pro-
cess. However, if you are not sure 
whether you want to leave a feature in 
or out, leave it in. You can always crop 
it out later. 

So let’s start by cropping the image. 
Crop is an image transformation, 
located in the Transformation menu. 

Click on the menu. You will notice that 
it contains a long list of operations. The three major categories are Geometry, Gray, 
grayscale (i.e. black and white) operations for controlling brightness and contrast. Colo
color balance and color saturation. Geometry is the one we want to choose. In additio
for resizing images and for controlling perspective.
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his example, we dragged the right 
p rectangle to the left to cut out the 
e result is below.
Menu Index Contents

The Crop Procedure
To crop the image:

1. Click on the image window to make sure that it is selected. 
In Picture Window, you select the image window first and then 
select a transformation for operating on the image. 

2. Display the Crop/Add Border Transformation. In the 
Transformation menu, select Geometry and then select 
Crop/Add Border. The dialog box is displayed. Notice also, 
that there are little open squares in each corner of the image. 
These are “handles” that you can drag with the mouse to 
adjust the cropping rectangle.

3. Drag the crop rectangle handles to achieve the crop you 
desire. You can drag the corners or edges to adjust the size of 
the rectangle. You can also drag the interior of the rectangle to 
reposition it without changing its size. 

To make fine adjustments, enlarge the image window by press-
ing the tool bar button or selecting the Zoom In menu 
choice in the Window menu.

4. Preview the crop. To see the effect of the crop, click Pre-
view. A small version of the image is displayed in a preview 
window. You can enlarge the preview window too, by selecting 

Cropping: In t
edge of the cro
extra space. Th
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ents and preview the image again 

ithout leaving the dialog. The pre-
nges can often be applied much 

ropped image is displayed in a new 
tton instead. Clicking Apply leaves 

lick the  button in the tool bar 

and the 
 per-
n com-
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 helpful 
hand, if 
s image 

rouble finding the window you 
indows tab at the bottom of the 

uble-click on its title. 
Menu Index Contents

the window and pressing the tool bar button. You can make further adjustm
as many times as necessary.

Most dialogs have a Preview button. It lets you see the results of your editing w
view image has only as much resolution as is needed for the screen, so your cha
faster than to the full image. 

5. Click OK. When you are satisfied with the changes, click the OK button. The c
image window. (Note, if you want to try additional variations, click the Apply bu
the dialog up and allows you to make additional images.)

Hint: Sometimes transformation dialogs get buried under other windows. Just c
to bring all transformation dialogs to the top.

Pipeline Editing
Notice that you now have two image windows—one with the unchanged original image 
other with the changed new image. In Picture Window, most editing operations are not
formed in place on the original image, but rather produce a new image. That way you ca
pare the new version with the previous one and continue from the one you like best. Al
can easily return to a previous version, even if it’s several stages back. This is particularly
when you are experimenting. You can save any image to a file at any time. On the other 
you don’t think you will be returning to a particular intermediate step, you can delete it
window, to conserve memory. 

As you continue editing and the number of open windows accumulate, you might have t
need. One way to locate the right window is to use the Windows Display (Click the W
Browse display.) It shows a hierarchical list of open windows. To select a window just do
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rs with the white of the border. 
giving the photo more snap. Simi-
uld want to make them darker.
Menu Index Contents

Adjusting Brightness and ContrasAdjusting Brightness and ContrasAdjusting Brightness and ContrasAdjusting Brightness and Contras
Usually, brightness and contrast are among the most important adjustments you 
can make. You can think of brightness as being how light or dark the midtones of 
the image are. Contrast is the range of tones—from the darkest shadows to the 
lightest highlights. 

Usually your goal is to make the shadows as dark as possible while retaining just a 
hint of texture and detail in most of the shadow areas. Likewise, you usually want 
to adjust the highlights so they are as white as possible, but also with a little bit of 
texture and detail. Finally, you want to adjust the midtones so they look realistic. 

Evaluating the Sample Image
Let’s look at the sample image with these criteria in mind. Compare the brightest feathe
They are not nearly as bright. Thus the bright areas of the bird could be made brighter, 
larly, check the blacks. In this example they are satisfactory, but if they were not, we wo
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ill use a simple and very effective 
nd brightness as well as color bal-
tures. See Levels and Color Dia-
Menu Index Contents

Using the Levels and Color Transformation
Picture Window has several transformations for adjusting brightness and contrast. We w
transformation called Levels and Color. It gives you independent control of contrast a
ance and saturation. In this example, we will only explore its contrast and brightness fea
log for information on its color controls.) 

The Levels and Color Procedure
To use the Levels and Color dialog:

1. Select the image window containing the image you want 
to adjust. 

2. Display the Levels and Color Dialog. In the Transfor-
mation menu, select Gray and then select Levels and 
Color. The Levels and Color dialog box is displayed. 

Notice the position of the shadow and highlight sliders on 
the Dynamic Range control. Picture Window sets these slid-
ers to the actual brightness level of the shadow and highlight 
areas of the image. (When you move the sliders, a small scale 
mark shows their original positions.) For instance, we can 
see that the brightest area in our image is only about 69% of 
full possible brightness. 
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. A good starting point for this 
e shadow and highlight sliders to 
ectively, and preview the image. 

e, the higher the contrast of the 
ou can actually move them past the 
ts. That has the effect of emphasiz-
increasing the contrast in the rest 

r. The Midtones slider affects the 
 for the most natural brightness 
e set the brightness to about +25%

. To see the effect of the adjust-
ersion of the image is displayed in a 
ith different settings and preview 
h the image.

h the adjustment. A new image is 

e Applying a Transformation 
Menu Index Contents

3. Adjust the dynamic range
adjustment is to simply move th
maximum black and white, resp

The further apart the sliders ar
image. For very high contrast, y
maximum white and black poin
ing highlights and shadows and 
of the image.

4. Adjust the Midtones slide
mid-range tones most. Adjust it
level for the subject at hand. W

5. Preview the adjustments
ments, click Preview. A small v
preview window. Experiment w
again, until you are satisfied wit

6. Click OK when satisfied wit
created in its own window. The dialog box is dismissed.

Note that you can also create a new image by pressing Apply instead of OK. Se
for a discussion of the two buttons.

The original image 
and after cropping 
and Levels adjust-
ment
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 If they are satisfactory, click 
. 

e image into balance, the Color 
ransformation determined that it 
act green. (Note the Remove 
tch above.) The results are shown 
e that the feathers are whiter and 
 redder. The blue highlights in the 
e also more prominent. 
Menu Index Contents P

AdjustingAdjustingAdjustingAdjusting
Color BalanceColor BalanceColor BalanceColor Balance
Notice that the whites in the feathers actually have a 
green tinge. We can remove this tinge by rebalancing 
the colors of the photograph, using the Color Bal-
ance transformation.

1. Select the image window containing the 
image you want to adjust. 

2. Display the Color Balance transformation. 
In the Transformation menu, select Color 
and then select Balance. The Color Balance 
dialog box is displayed. 

3.  This transformation tries to determine the 
correction needed to balance the image. Its 
guess is frequently quite close. Click Preview to see the results of auto-correction.
OK to create a new image. The auto-correction results in our case are shown below

To bring th
Balance t
must subtr
highlight pa
at left. Not
the beak is
feathers ar
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ettings are simply the defaults.

K to create a new image. The 
Menu Index Contents

Sharpening the ImageSharpening the ImageSharpening the ImageSharpening the Image
Images in which texture or fine detail are important can frequently 
be improved by sharpening their focus. In this image, the feather 
structure is a bit soft, so it is a good candidate for sharpening. To 
sharpen an image:

1. Select the image window containing the image you 
want to adjust. 

2. Display the Sharpen Transformation transformation. 
In the Transformation menu, select Sharpen. The 
Sharpen dialog box is displayed. 

3. There are several sharpening methods. We chose 
Unsharp Mask, which is a good general-purpose sharpening method. All other s

4. Click Preview to see the results of the sharpening. If they are satisfactory, click O
original and final images are shown below.

Sharpening brings out 
the texture of the 
feathers. 

The amount of sharp-
ening you can apply 
before artifacts start 
becoming noticeable is 
different for each 
image. In this case we 
sharpened the image 
twice. 
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 moving the slider either to the 
ge.
Menu Index Contents

AdjustingAdjustingAdjustingAdjusting
Color SaturationColor SaturationColor SaturationColor Saturation
After sharpening the image, we see that the colors look rather 
bleached. We can bring them out by increasing saturation.

1. Select the image window containing the image you 
want to adjust. 

2. Display the Color Saturation transformation. In the 
Transformation menu, select Color and then select 
Saturation. The Saturation dialog box is displayed. 

3. The transformation can be used to either increase or decrease the saturation by
right or left.  Experiment to find the best setting. Click OK to create a new ima

Increasing saturation 
by about 40% brings 
out the colors of the 
beak and the blue 
around the eye.

Setting the Preserve 
option to Low keeps 
areas of low satura-
tion unaffected. 
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educe the degree of change in each 
Menu Index Contents

Lightening a Small AreaLightening a Small AreaLightening a Small AreaLightening a Small Area
Eyes are frequently very important in drawing us into an image. In this 
particular case, they are a bit ‘dead’. Highlights that can make eyes come 

alive are not very evident. However, if we 
look closely (detail, left), we can see that 
highlights do exist. So all we have to do is 
make them standout more.

Picture Window has a series of paint brush- 
like tools for making local changes. In this 
case, we will use the Lighten tool to selec-
tively lighten the iris of the eye. 

To use the tool:

1. Select the image window containing the image you want to 
adjust. 

2. Enlarge the image. Click the  Zoom button in the tool-
bar. Then place the cursor over the eye and click the left mouse 
button until the eye fills the image window.

3. Display the Miscellaneous Tools dialog. In the Tools menu, 
select Miscellaneous Tools. This dialog offers many tools, any of 
which can be chosen from the drop-down menu. We will use the Lighten tool.

4. You can set the tool’s Transparency and Softness. Set these to high values to r
pass of the tool. That makes it easier to control the effect. 
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the tool. Set the Radius slider so 

se, we circled around the iris, mak-
ly on the image. (If you make a mis-

 an Image.)
Menu Index Contents

5. Move the mouse over the image. A small circle is displayed. It shows the size of 
that the circle is somewhat smaller than the area you want to change. 

6. Hold down the mouse button and go over the area you want to lighten. In our ca
ing a number of irregular passes to brighten it. Notice that the tool works direct
take or overdo the change, use Undo to reverse your action.) 

The results are shown below.

The original and final image are shown at the beginning of the chapter. (See Evaluating

The final step is to save the image, described next.

 

We traced several passes 
around  the iris to lighten it 
and make the eye glisten.

We also added a small high-
light to the pupil with the 
Paint Tool.

The result is to bring out the 
eye’s spherical shape and to 
make it look more alive. 
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 Windows File Save dialog is dis-

or one of the other uncompressed 
sing as little storage space as possi-

ter a file name for the image.

e image is saved. 

default settings and click OK. The 
Menu Index Contents

Saving the ImageSaving the ImageSaving the ImageSaving the Image
After you have adjusted the image, save it in a file. Here is the procedure:

1. Select the image window containing the image you want to save. 

2. Display the Save As Dialog. In the File menu, select Save As. The standard
played. 

3. Set the file type. If you intend to continue working on the image, select TIFF 
formats. If you have completed working with the image, and want to archive it u
ble, save it as a JPEG compressed file. 

4. Select the drive and directory in which you want to store the image and en

5. Press OK to complete the operation. For all file types except JPEG, th

For JPEG images, the JPEG File Save Dialog dialog is displayed. Accept its 
image is saved. 
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rmations we performed, cropping, 
n, images frequently have dust 
tool. (Also see the Image 

nd on your creative purpose. 
photographs. 

cedures that are common to most 
Menu Index Contents

Using Other TransformationsUsing Other TransformationsUsing Other TransformationsUsing Other Transformations
This chapter is only an introduction to the transformations at your disposal. The transfo
adjusting brightness, contrast, and color balance are required by most images. In additio
marks and other small imperfections which can be removed with the Speck Removal 
Retouching Techniques white paper for an in-depth discussion.)

However, the manipulations you will want to perform ultimately depend on the image a
Picture Window provides a very rich set of tools to help you get the most out of your 

In the next chapter, we introduce all of the Picture Window functions and describe pro
of the manipulations.
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